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Abstract 

This study aims to analyze the effect of social media marketing on donation intentions 

with the mediation of brand image and brand trust. This study uses a quantitative 

method with the SEM-PLS analysis approach, involving 171 respondents who are 

active social media users but have never donated through Kitabisa.com. Data were 

collected through an online questionnaire. The results of the study show that social 

media marketing has a significant effect on brand image and brand trust. Social media 

marketing also has a significant effect on donation intentions. Brand trust has a 

significant direct effect on donation intentions, while brand image does not show a 

significant direct effect. In addition, brand trust is proven to be a significant mediator 

between social media marketing and donation intentions, while brand image does not 

have a significant mediation effect. 
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INTRODUCTION 

The development of digital technology, especially the internet, has brought 

significant changes to various aspects of human life. The internet has become an important 

infrastructure that enables communication and access to information globally. One sector that 

has experienced a major transformation is the financial sector, where financial technology or 

fintech has changed the way people interact with financial services. Fintech includes a variety 

of services, including digital payments, online loans, investments, and internet-based 

fundraising, all of which utilize technology to increase accessibility and efficiency (Sari, 

2019). 

One fintech innovation that has gained widespread attention is crowdfunding. 

Crowdfunding is a fundraising method where individuals or organizations can raise funds 

from a large number of people, usually through an online platform. This crowdfunding model 

has been used for a variety of purposes, from funding small businesses to social and 

charitable projects. Donation-based crowdfunding, in particular, allows the wider community 

to contribute directly to supporting social and humanitarian initiatives (Aziz et al., 2019). 

In Indonesia, crowdfunding platforms such as Kitabisa.com are no stranger. Founded 

in 2013 by Alfatih Timur, Kitabisa.com enables individuals, communities, and organizations 

to raise funds for various social, humanitarian, and personal needs, such as health costs, 

education, disaster relief, and other social projects (Lukman, 2013). Since its founding, the 

platform has raised more than IDR 500 billion from more than 10 million donors to support 

63,964 campaigns (as of May 2020). However, with a total population of Indonesia of around 

281.6 million in 2024, the relatively small number of donors raises questions regarding the 

factors that influence people's intention to donate through crowdfunding. 

Donation intention is influenced by factors such as trust in the organization, brand 

image perception, and emotional involvement (Y. Chen et al., 2019). Social media plays a 

major role in influencing donation intention, as it can attract attention and touch the emotional 

aspects of potential donors. Social media marketing allows crowdfunding platforms to reach 

a wider audience, deliver effective messages, and build a solid community of supporters 

(Haudi et al., 2022). However, challenges arise in ensuring effective promotion and not just 

generating superficial support (Aziz et al., 2019). 



Indonesian Interdisciplinary Journal of Sharia Economics (IIJSE)                  Vol. 8. No. 1 (2025)  

e-ISSN: 2621-606X               Page: 2056-2070 

The Influence of Social Media Marketing….. 2058 

 

Kitabisa.com utilizes social media such as Instagram, TikTok, Facebook, and Twitter 

to expand the reach of the campaign, with informative and emotional content to attract 

potential donors (Salsabila & Hasbi, 2021). Brand image and brand trust play a key role in 

donor decisions. A positive brand image reflects credibility, while brand trust ensures that 

donation funds are distributed appropriately and transparently (Gregory et al., 2019; Zhang 

et al., 2021). Further research is recommended to develop variables such as Social Media 

Marketing, Brand Image, Brand Trust, and Donation, along with SEM and PLS methods 

(Adyani, 2021). In addition, research by Bilgin & Kethüda (2022) suggests expanding the 

sample and exploring marketing strategies in various non-profit organizations to understand 

their impact more dynamically. 

Brand image and brand trust are key factors influencing donor decisions. A positive 

brand image reflects consumers' perceptions of a platform's credibility and integrity (Gregory 

et al., 2019). On the other hand, brand trust is consumers' belief that the platform can be relied 

on to channel donation funds appropriately and transparently (Zhang et al., 2021). In the 

context of crowdfunding, a strong brand image and a high level of trust are essential to ensure 

the success of a fundraising campaign and consumers' intention to donate. As research by 

Adyani (2021) suggests, further researchers should develop variables such as Social Media 

Marketing, Brand Image, Brand Trust, and Donation, as well as apply methods such as SEM 

and PLS to expand the scope of marketing research that is relevant to technological 

developments. Meanwhile, another study conducted by Bilgin & Kethüda (2022) discusses 

the limitations of the sample that only involves charity followers on certain social media and 

focuses on non-governmental organizations. Further research is recommended to expand the 

variety of samples, including individuals who are not familiar with charities, and explore 

marketing strategies in various non-profit organizations to understand their impact more 

broadly and dynamically. 

Therefore, This study aims to analyze the influence of social media marketing on 

brand image, brand trust, and donation intention on crowdfunding platforms. Not only that, 

this study also aims to explore whether brand image and brand trust mediate the influence of 

social media marketing on donation intention. In this case, it will also be analyzed how brand 
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image and brand trust influence each other and whether both act as mediators in the 

relationship between social media marketing and donation intention. 

 

REVIEW OF LITERATURE 

Theory of Planned Behavior (TPB) 

Theory of Planned Behavior (TPB) was developed by Ajzen (1991) to understand the 

intention to donate. TPB explains that a person's intention to take action is influenced by 3 

main factors: attitude toward the action, subjective norms, and perceived behavioral control. 

Intention to donate, as a predictor of actual behavior, is influenced by these factors, as well 

as by other elements such as social media marketing, brand image, and brand trust. 

Social Media Marketing 

Social media plays a key role in disseminating information related to crowdfunding. 

According to Rulli (2015) social media allows users to share information, interact, and build 

communities that support certain goals. Platforms such as Facebook, Instagram, TikTok, and 

Twitter are widely used to promote crowdfunding platform campaigns.enables fundraising 

from many individuals for a specific purpose, either in a social or commercial 

context.because of its ability to reach a large audience at a relatively low cost. In the context 

of crowdfunding social media marketing, there are six main dimensions that influence the 

success of a campaign: Awareness, Interaction, Timeliness, Informativeness, Customization, 

and Advertising. 

Brand Image 

According to Coaker (2021), Tharpe (2014), Simonson and Schmitt (2009), brand 

image is a comprehensive analysis of a person's opinion of a brand based on previous 

customer data and experiences. Because it influences consumers' purchasing decisions, brand 

image is very important. Customers are more likely to choose and buy a product if they have 

a good opinion of the brand. 

Brand Trust 

Brand trust is defined as consumer confidence in a brand's ability to meet their 

expectations. According to Doney and Cannon (1997), brand trust includes the sense of 
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security consumers feel when using a particular brand. This trust arises after consumers 

appreciate the quality of products and services provided by the company. 

Intention to Donate 

Donation intention is a person's tendency or commitment to make a donation in the 

future. This intention is a major predictor of actual behavior, where individuals are influenced 

by attitudes, social norms, and perceived control over the act of donating. 

Research Framework 

 
Figure 1 

Research Framework 

Hypothesis Testing: 

H1 : Social media marketing of crowdfunding platforms has a positive effect on the brand 

image of the crowdfunding platform. 

H2 : Social media marketing of crowdfunding platforms has a positive impact on brand 

trust 

H3 : Social media marketing of crowdfunding platforms has a positive effect on donation 

intentions 

H4 : Crowdfunding Platform Brand Image has a positive effect on brand trust 

H5 : Crowdfunding Platform Brand Image has a positive influence on donation intention 

H6 : Brand trust has a positive effect on donation intentions 

H7 : Brand Image Mediates the Influence of Social Media Marketing on Donation 

Intention 

H8 : Brand trust mediates the influence of social media marketing on donation intention 
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RESEARCH METHOD 

This study uses a quantitative approach with Structural Equation Modeling–Partial 

Least Squares (SEM-PLS) analysis using SmartPLS 4. The object of the study is the 

Kitabisa.com crowdfunding platform, with subjects being active social media users who 

know Kitabisa.com but have never donated. Primary data were obtained through 

questionnaires from 171 respondents selected using purposive sampling techniques, with the 

criteria of social media users aged at least 17 years, knowing Kitabisa.com, and having never 

donated. Data analysis was carried out through validity and reliability tests on the outer 

model, along with hypothesis testing and mediation evaluation on the inner model using R-

Squared, Effect Size, and bootstrapping. The suitability of the model was tested using 

Goodness of Fit (GoF). 

 

RESULTS AND DISCUSSION 

Instrument and Data Quality Test 

 
Figure 2 

Outer Loading Results 
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Convergent Validity 

Table 1  

Convergent Validity Test Results 

 Brand Image Brand Trust Intention to Donate 
Social Media 

Marketing 

Image 1 0.836    
Image 2 0.793    
Image 3 0.825    
Image 4 0.845    
Trust 1  0.879   
Trust 2  0.822   
Trust 3  0.861   
Trust 4  0.835   
Intention 1   0.887  
Intention 2   0.832  
Intention 3   0.835  
Intention 4   0.834  
PMS1    0.799 

PMS2    0.785 

PMS3    0.795 

PMS4    0.793 

PMS5    0.798 

PMS6    0.777 

PMS7    0.822 

PMS8    0.783 

PMS9    0.793 

PMS10    0.762 

PMS11    0.835 

PMS12    0.816 

PMS13    0.757 

PMS14    0.803 

PMS15    0.804 

PMS16    0.749 

PMS17    0.842 

PMS18    0.823 
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According to Haryono, (2016) to measure convergent validity by looking at the 

loading factor. Based on the table, it can be seen that if the Loading factor value of all 

question items is > 0.70, then it can be said that all question items are called convergent valid. 

Discriminant Validity 

Table 2 

Discriminant Validity Test Results 

Variables Average Variance Extracted (AVE) 

Social Media Marketing 0.635 

Brand Image 0.680 

Brand Trust 0.722 

Intention to Donate 0.718 

All variables of this study have an Average Variance Extracted (AVE) value > 0.50, 

indicating that convergent validity is met (Ghozali, 2016). With the Social Media Marketing 

variable having an AVE value of 0.635. Brand Image has an AVE value of 0.680, the Brand 

Trust variable recorded the highest AVE value of 0.722, Finally, the Intention to Donate has 

an AVE value of 0.718. Thus, all variables are declared valid in representing their indicators. 

Reliability Test 

Table 3 

Reliability Test Results 

 Cronbach's Alpha Composite Reliability (rho_c) 

Brand Image 0.843 0.895 

Brand Trust 0.872 0.912 

Intention to Donate 0.869 0.911 

Social Media Marketing 0.966 0.969 

The results of the reliability test show that all constructs have very good reliability 

and are more than 0.7. With each construct having a value: Brand Image has a Cronbach's 

Alpha value of 0.843 and Composite Reliability (rho_c) of 0.895, Brand Trust Construct has 

a Cronbach's Alpha of 0.872 and Composite Reliability of 0.912, Intention to Donate with a 

Cronbach's Alpha value of 0.869 and Composite Reliability of 0.911. The Social Media 

Marketing Construct shows a Cronbach's Alpha of 0.966 and Composite Reliability of 0.969. 

Overall, these four constructs have consistent reliability and can be relied on in measuring 

the variables in the study. 
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Inner Model Evaluation 

R-Squared (R²) 

Table 4 

R-Squared (R²) Test Results 

 R-square R-square adjusted 

Brand Image 0.908 0.907 

Brand Trust 0.910 0.909 

Intention to Donate 0.913 0.912 

 

The test results show that the model can explain significant variations in the three 

constructs. Brand Image is explained by 90.8%, Brand Trust by 91%, and Donation Intention 

by 91.3%, with a stable model and minimal adjustments to the adjusted R-square. Overall, 

this model is very good at explaining the variations in the three constructs. 

Effect Size (f²) 

Table 5 

Effect Size Test Results (f²) 
 Brand Image Brand Trust Intention to Donate 

Brand Image  0.081 0.036 

Brand Trust   0.093 

Intention to Donate    

Social Media Marketing 9,856 0.479 0.167 

The results of the analysis show that social media marketing has a strong impact on 

brand image (value 9.856) and brand trust (value 0.479), but its influence on donation 

intention is moderate (value 0.167). The influence of brand image on brand trust (0.081) and 

donation intention (0.036), as well as the influence of brand trust on donation intention 

(0.093) is relatively weak. This shows that although social media marketing is effective in 

building brand image and trust, improvements are still needed to increase donation intention. 

Hypothesis Testing 

It is done by bootstrapping method. Through bootstrapping, it will be seen whether 

the independent variable (X) has a significant influence on the dependent variable (Y) or, it 

will be seen whether the mediating variable has a significant influence in the relationship 
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between the independent variable (X) and the dependent variable (Y) in the relationship 

between variables and The significance of the relationship is observed by the p value or t-

statistic. If the p value <0.05, then the mediation effect is considered significant (Hamid & 

Anwar, 2019). 

Direct Effect 

Table 6 

Direct Effect Path Test Results 

Track Path Coefficient T statistics P values 

Brand Image -> Brand Trust 0.280 2,768 0.006 

Brand Image -> Intention to Donate 0.191 1,938 0.053 

Brand Trust -> Donation Intention 0.299 3.321 0.001 

Social Media Marketing -> Brand Image 0.953 93,447 0.000 

Social Media Marketing -> Brand Trust 0.683 6.916 0.000 

Social Media Marketing -> Intention to 

Donate 0.482 4.271 0.000 

The results of the study show that social media marketing has a significant influence 

on the variables studied, namely brand image, brand trust, and intention to donate. 

The Influence of Social Media Marketing on Brand Image 

The influence of social media marketing on brand image is very strong, as indicated 

by the path coefficient of 0.953 and the P-value of 0.000. These results are similar to previous 

theories and studies, as explained by Gregory et al. (2019), if effective social media 

marketing can increase positive perceptions of brand image. Creative, relevant, and 

informative campaigns on social media allow platforms like Kitabisa.com to build a credible 

brand image and attract the attention of the wider community. 

The Influence of Social Media Marketing on Brand Trust 

In addition, social media marketing also has a significant influence on brand trust, 

with a path coefficient of 0.683 and a P-value of 0.000. These results are similar to research 

by Zhang et al. (2021), stating that transparent and communicative digital marketing helps 

build consumer confidence in the integrity and credibility of crowdfunding platforms. 

The Influence of Social Media Marketing on Donation Intention 

The effect of social media marketing on donation intention is also significant, with a 

path coefficient of 0.482 and a P-value of 0.000. This finding supports the study of Bilgin & 
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Kethüda (2022), showing that social media marketing strategies not only expand the reach 

of campaigns but also increase the likelihood of donations through the delivery of emotional 

and informative messages. 

The Influence of Brand Image on Trust and Intention to Donate 

The results of the study also show that brand image has a significant influence on 

brand trust (path coefficient 0.28; P-value 0.006). This supports the research of Gregory et 

al. (2019), explaining that a strong brand image increases consumer trust in the credibility of 

the platform. However, brand image does not have a significant effect on the intention to 

donate (P-value 0.053). These results indicate that a positive perception of brand image alone 

is not enough to encourage the intention to donate without deep trust in the platform. 

The Influence of Brand Trust on Donation Intention 

Brand trust has a significant influence on donation intention, with a path coefficient 

of 0.299 and a P-value of 0.001. This finding strengthens the argument of Zhang et al. (2021), 

who emphasized the importance of trust as a major factor in donation decision making, 

especially in crowdfunding platforms. Brand trust ensures that donors feel confident that their 

funds will be distributed appropriately and transparently. 

Indirect Effect 

Table 7 

Indirect Effect Path Test Results 

Track Path Coefficient T statistics P values 

Social Media Marketing -> 

Brand Trust -> Donation 

Intention 

0.204 2,805 0.005 

Social Media Marketing -> 

Brand Image -> Donation 

Intention 

0.182 1,935 0.054 

Brand Image Mediation 

The results show that brand image does not function as a significant mediator between 

social media marketing and donation intention (P-value > 0.05). This indicates that although 

social media marketing can improve brand image, its influence is not strong enough to drive 

donation intention through this mediation. According to Plummer (2007), brand image 
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reflects consumer perception, but in the context of donation, decision making is more 

dependent on trust and emotional involvement. 

Brand Trust Mediation 

In contrast, brand trust proved to be significant as a mediator (P-value <0.05). This 

result is similar to research by Adelia et.al (2023), which emphasized the importance of trust 

in decisions involving risks such as donations. Transparent and consistent social media 

marketing can increase donor confidence that funds will be managed well, as also 

emphasized by Chen et al. (2019).   

Goodness of Fit (GoF) 

Goodness of Fit (GoF) will be measured to see how well the overall model fits the 

data. The GoF value combines communality and R², with a larger GoF value indicating a 

better fit, with a rating of 0.1 (small GoF), 0.25 (moderate GoF), 0.36 (large GoF). According 

to Haryono, (2016) Goodness of Fit can be measured using the formula: 

√𝑅𝑎𝑡𝑎 − 𝑟𝑎𝑡𝑎 𝐴𝑉𝐸 𝑥 𝑅𝑎𝑡𝑎 − 𝑟𝑎𝑡𝑎 𝑅𝑆𝑞𝑢𝑎𝑟𝑒𝑑 

Table 8 

Goodness of Fit 

 (AVE) R-square 

Brand Image 0.68 0.908 

Brand Trust 0.722 0.91 

Intention to Donate 0.718 0.913 

Social Media Marketing 0.635  
Average 0.688 0.910 

 

GOF value =√𝑟𝑎𝑡𝑎 − 𝑟𝑎𝑡𝑎 𝐴𝑉𝐸 𝑥 𝑟𝑎𝑡𝑎 − 𝑟𝑎𝑡𝑎 𝑅 𝑆𝑞𝑢𝑎𝑟𝑒 

GOF value =√0,688 𝑥 0,910 

GOF value = 0.792 

Based on the calculation results, the GoF value obtained was 0.792, this shows that the 

combined performance of the outer model and inner model in this study can be classified into 

the large GoF category. 
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CONCLUSION 

Based on the results of the research data analysis and calculations of the influence of 

media marketing on the intention to donate with brand image and brand trust as mediators, 

namely: 

1. The Social Media Marketing Path -> Brand Image produces a p-value of 0.000 < 0.05 

so that H1 is accepted, namely Social Media Marketing has a significant effect on Brand 

Image. 

2. The path of Social Media Marketing -> Brand Trust produces a p-value of 0.000 < 0.05, 

so H2 is accepted, namely that Social Media Marketing has a significant effect on Brand 

Trust. 

3. The Social Media Marketing Path -> Intention to Donate produces a p-value of 0.000 < 

0.05 so that H3 is accepted, namely Social Media Marketing has a significant effect on 

Intention to Donate. 

4. The Brand Image -> Brand Trust path obtained a p-value of 0.006 < 0.05, so H4 is 

accepted, namely that Brand Image has a significant effect on Brand Trust. 

5. The Brand Image -> Intention to Donate path produces a p-value of 0.053 > 0.05, so H5 

is rejected, namely that Brand Image does not have a significant effect on Intention to 

Donate. 

6. The Brand Trust -> Intention to Donate path produces a p-value of 0.001 < 0.05 so that 

H6 is accepted, namely that Brand Trust has a significant effect on Intention to Donate. 

7. The path of Social Media Marketing -> Brand Image -> Intention to Donate produced a 

p-value of 0.054 > 0.05, so H7 was rejected, namely that Social Media Marketing does 

not have a significant effect on Intention to Donate through Brand Image. 

8. The path of Social Media Marketing -> Brand Trust -> Intention to Donate produces a 

p-value of 0.005 < 0.05, so H8 is accepted, namely Social Media Marketing has a 

significant effect on Intention to Donate through Brand Trust. 

This study suggests that platforms such as Kitabisa.com optimize social media 

marketing through transparent content and donor testimonials to build trust. Communication 

strategies also need to focus on increasing brand trust through clear financial reports. 

Although brand image does not directly affect donation intentions, strengthening it is 
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important to attract new audiences. Proper audience segmentation can also increase campaign 

effectiveness. Theoretically, this study supports the development of the Theory of Planned 

Behavior (TPB) by emphasizing the important role of trust as a mediator in the influence of 

social media marketing on donation intentions. This study also enriches the digital marketing 

and crowdfunding literature by showing the relationship between brand image, brand trust, 

and donation intentions. 

Further research is recommended to develop research on other crowdfunding 

platforms, add variables such as donation motivation or social influence, and conduct long-

term research to understand changes in donation behavior, especially in external conditions 

such as economic crises. For Kitabisa.com, it can increase donations and brand image by 

increasing interaction through Q&A and direct discussions, expanding reach with 

influencers, and ensuring up-to-date information. In addition, responsiveness can be 

increased with chatbots, as well as displaying testimonials and success stories. Transparency 

of funds needs to be maintained with regular audits, and a focus on the real impact of 

donations. 
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